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�  
 

Није знање знање знати,  
већ је знање знање дати! 

 
 

ПРЕДГОВОР 
 
 Дуго је трајало премишљање да ли овај посао радити. Треба ли младим 
интелектуалцима давати упутства како да нешто ураде? Ипак, дугогодишње 
искуство у раду са људима, поготово младима ми је потврдило нешто што је 
неко уман већ срочио: Постоје ствари које мислимо да знамо, а које нас, 
заправо, спречавају да научимо све оно што би требало да сазнамо. 

Пошто је одлука донета, никло је питање: Како то урадити, а да не буду 
повређени сујета и интелигенција? Млади људи су део друштва од којег се 
очекује да се развија брже и квалитетније од осталих. Од студената се очекује 
још више, јер треба да се развију у најодговорнији, најинтелектуалнији слој, 
који ће кроз релативно кратак временки период избити на чело и водити 
читаво друштво даље. Ето зашто је битно да ваша знања, вештине и 
способности буду развијени, поуздани и максимално изграђени. 

Као скроман допринос вашем развојном путу, ево практичног упутства за 
припрему једног од најчешћих видова студентских задатака - израда 
семинарских радова. Упутство пред Вама је намењено студентима свих нивоа 
студија Биологије и Екологије на Природно-математичком факултету 
Универзитета у Крагујевцу. Надам се да ће Вам бити јасно и корисно, без 
обзира да ли рад треба да буде „брањен“ или не, одштампан или предат у 
електронској верзији. 

Циљ овог упутства јесте да студенту биологије помогне да што лакше и 
правилно уради семинарске радове на теме које током студија добија, да му 
израда завршног (мастер/дипломског) рада не буде проблем, као и да стекне 
вештине за евентуално писање научних и стручних радова у будућој 
академској и/или научној каријери. Томе треба да допринесу и прилози дати 
на крају овога текста. 

Процес учења траје читавог живота. Упутство, колико год било детаљно, 
садржи недостатке и даје простора за допуњавање. Не замерите писцу, већ 
сугеришите шта би ваљало дорадити или преправити. Унапред Вам хвала. 
Учимо заједно. Најбоље, мада не баш пријатно, је учење на сопственим 
грешкама. Признајем! 
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1.  УВОД 
 

Семинарски рад је самостално дело студента, у којем, по упутствима 
ментора или предметног(их) наставника1, обрађује задату или самостално 
изабрану, теоријску или практичну тему.  

Циљ писања семинарских радова је да студент развије и покаже 
способност да самостално, у пару или групно, реши практичне и/или 
теоријске задатке из одређене научне дисциплине.  

Семинарски рад не мора представљати оригинално научно достигнуће, 
већ је углавном компилација података из различитих, валидних, ауторизованих 
научних извора, пажљиво бираних, сложених у логичну целину, која најбоље 
одговара задатој теми.  

Веома је важно да овакви радови поштују правила академског писања, са 
акцентом на исправно цитирање извора података.  

 
Ипак, пре свега разјашњење шта јесте семинарски рад и по чему је 

другачији од научног и стручног рада. 
 

Семинарски радови су део образовног процеса, тј. вид реализације 
наставних задатака. Током њихове израде студент/ученик2 самостално, или као 
члан групе, истражује прикупљајући доступне податке и сазнања на задату 
тему, бира и систематизује прикупљени материјал, пише рад од изабраних 
података, и потом, уколико је тако предвиђено наставним програмом, на часу 
подели своја сазнања са колегама са студија у временски ограниченом термину 
(тзв. јавна одбрана). Очигледно да се за израду семинарског рада користе 
сазнања до којих су дошли стручњаци и научници из области из које је задата 
тема, те се од студента очекује само да темељно прикупи, прегледа и пажљиво 
пробере литературне изворе које ће користити при писању рада, као и да их 
успешно, јасно и сигурно презентује (ако је предвиђена јавна одбрана). Израда 
презентације која прати семинарски рад тако постаје још један сегмент 
студентских обавеза везаних за израду семинарског рада. Међутим, на неким 
предметима није предвиђена јавна одбрана, већ рад само достављате 
наставнику у заказаном термину. 

Научни радови, пак, јесу резултат истраживачког бављења одређеном 
научном темом. Они садрже информације и чињенице нове за научну јавност, 

                                                           
1 У даљем тексту ће писати „наставник“, тј. у једнини, а подразумеваће и евентуално 
укључивање више наставника. Под „наставник“ се подразумевају сва факултетска наставна 
звања. 
2
 У модерном образовном систему и ученици основних и средњих школа добијају такве задатке! 
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тј. поред информативне имају и развојну улогу у одређеној научној 
дисциплини. Могу бити плод личних истраживачких напора (експеримената, 
проучавања процеса, појава, и сл.), откривати и дефинисати научне принципе, 
законе и теорије, нудити нове методе и технике, предлагати решења и моделе, 
или давати потврде постојећим, тј. бити оригинални научни радови. Али, 
научни радови могу бити и прегледи истраживања на одређену тему који 
укључују историјат развоја сазнања по тој теми, као и сопствене и туђе 
резултате (то су тзв. ревијални радови). Уколико је научна информација коју 
рад садржи кратка, тј. новина коју треба што пре обзнанити у научним 
круговима, онда је то „кратки рад“ (енгл. short communication). Научни радови 
се објављују у научним часописима по строгим правилима које уредништва и 
издавачи дефинишу. Временом резултати најзначајнијих научних радова 
постају део студијског градива и бивају уграђивани у универзитетске уџбенике. 

Стручни радови немају научни значај у најужем смислу, већ доприносе 
развоју одређене професије, тако што представљају новине у процесу обављања 
одређених активности, унапређују постојеће технике и методе рада. Намењени 
су стручној публици, тј. колегама из исте области. Нпр. у домену методике 
наставе биологије овакви радови наставницима и професорима који у редовној 
школској пракси немају могућности да буду у току са савременим токовима и 
трендовима у настави пружају управо такве информације и нуде им 
могућности за побољшање наставног рада и успеха ученика. 

 
Која год верзија рада да је у питању очекивани резултат треба да буде 

оригинална логична целина, прегледна, информативна, јасна, чињенично 
поткрепљена личним и/или туђим резултатима, технички (графички) и 
лингвистички правилно написана. Другим речима, све што научите пишући 
семинарске радове касније ћете примењивати у академској и/или 
професионалној каријери. Стога, прионимо на посао. 
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2.  ПРИКУПЉАЊЕ ПОДАТАКА 

 
Први кораци у реализацији задате теме семинарског рада јесу 

истраживање литературe и сакупљање података из штампаних и електронских 
извора. Да би знали шта ћете од литературе тражити од других људи, у разним 
институцијама или преко интернета, треба да имате припремљен „кроки“, тј. 
опште контуре у оквиру којих ће се текст Вашег семинарског рада кретати. 
Уколико нисте сигурни да овај корак умете сами да урадите, обавезно 
потражите помоћ предметног наставника. 

Најбоље је да полазиште у трагању за подацима буде уџбеничка 
литература којом лично располажете из наставног предмета из којег је тема и 
сродних. Најпре су то уџбеници на српском, а потом и другим језицима. 
Зависно од теме семинарског рада, извори могу бити и енциклопедије, 
речници, атласи мапа и фотографија, „Службени гласник“ и сл. (уколико треба 
да се позовете на законску регулативу), електронске базе података доступне 
онлајн (неки предлози везани за таксономске податке нпр. су у Прилогу 3), па 
научни и стручни часописи, зборници радова са научних скупова, саветовања 
и др.  

Не заборавите – НИСУ СВИ ЛИТЕРАТУРНИ ИЗВОРИ ДОСТУПНИ 
ПРЕКО ИНТЕРНЕТА! Након прегледа сопствених уџбеника, питајте предмет-
ног наставника шта би Вам од литературе предложио и евентуално позајмио. 
Посетите и предаваче из сродних дисциплина. Не заборавите факултетску, 
универзитетску и градску библиотеку. Битно је да знате која дела Вам 
конкретно требају, како би други, који нису биолози, могли да помогну. За неке 
теме ће Вам можда користити и посета дечјој или школској библиотеци. Тек 
потом приступите интернет трагању.  

Како који литературни извор откријете, проанализирајте и потражите 
употребљиве, Вашој теми одговарајуће податке. У радни документ у рачунару, 
или руком у бележници, унесите податке о том извору, које ћете на крају 
користити за сређивање списка литературе - аутора(е), годину издања, наслов, 
издавача, странице и сл. У форми теза забележите и податке које ћете можда 
користити као такве, или комбиноване са сличнима из других извора. На крају 
претраге по литературним изворима имаћете прилично градивног материјала 
за писање. 

Осим текстуалних података међу чињенице које могу бити корисне 
спадају и табеле и слике позајмљене из других извора. Битно је да изабрани 
прилози буду стварно сврсисходни, тј. адекватни теми и тачни. Нпр. уколико 
имате задатак да пишете о шумским екосистемима, па желите да сликама 
прикажете неке од биљних врста, онда покушајте да пронађете такве слике које 
наликују шумском окружењу (а не из баште, саксије и сл.), или ако је у питању 
животиња покушајте да не изаберете слику где се види ограда зоолошког врта и 
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сл. Уколико Вам је избор веома сужен и баш немате други извор, или избегните 
да ту врсту прикажете сликом, или помоћу техничке обраде слике 
(обрезивањем, мењањем контраста и тд.) избегните нежељене делове. Пазите да 
не изаберете погрешни прилог, тј. да на слици није оно што сте потписали и о 
чему је у тексту реч. 

 
Важна напомена: Није згорег да су Вам „Правопис српскога језика“3 и 

„Речник српскога језика“ (без обзира на издање) при руци током склапања 
коначног текста семинарског рада. 
 
  

                                                           
3 Службено (од ресорних министарстава) су прихваћени „Правопис српскога језика“, аутора 
Митар Пешикан, Јован Јерковић и Мато Пижурица, и „Правопис српског језика“ Милорада 
Дашића. Детаљи о овим рефернцама су у попису литертауре, испред Прилога. 
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3. СТРУКТУРА И САДРЖАЈ 
СЕМИНАРСКОГ РАДА 

 
Као и ма који други писани текст, и семинарски рад у суштини има три 

основна дела – увод, разраду и закључак. Међутим, осим овог основног текста, 
семинарски рад обавезно на почетку има насловну страницу и садржај 
(уколико је рад дужи од пет страница). После текста рада следи списак 
коришћених литературних извора, евентуални прилози у виду табела или 
табли са графицима или сликама (као што их и ово Упутство има) и (веома 
ретко) индекси појмова и латинских назива.  

Обим семинарског рада (као и дужину излагања при „одбрани“) 
одређује предметни наставник, зависно од теме. 

 

3.1. Насловна страница 

 Насловна страница семинарског рада (погледати Прилог 1) је информа-
тивна. Садржи: назив високо-образовне институције на којој студент-аутор сту-
дира (универзитет, факултет, департман или институт) и евентуално амблеме 
универзитета и факултета; назив предмета из којег је семинарски рад; наслов 
рада (најкрупнијим словима, тако да је најуочљивији); наставно звање, име и 
презиме предметног наставника; име, презиме и број индекса студента-аутора, 
место и годину објављивања. Уколико жели, студент може на насловну 
страницу ставити и неку илустрацију која је у складу са темом. 
 

3.2. Садржај 

 Садржај рада се састоји од наслова и поднаслова које рад садржи, са 
бројевима страница на којима су (и ово Упутство има Садржај, па га 
проанализирајте). Садржај треба пажљиво средити, поштујући хијерархију 
наслова, јер он служи за навигацију читаоца кроз семинарски рад. Наслови у 
хијерархији  не треба да имају више од пет нивоа.  
 Кратки радови, до пет страница, обично немају Садржај. 
 

3.3. Основни текст  

Ово је, управо, део који садржи увод, разраду и закључак. У уводу треба 
кратко образложити тему рада, њен значај у ширем контексту наставног 
предмета из којег је семинарски рад и циљ писања тога рада. Уводом треба 
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наговештајем садржаја текста који следи заинтересовати читаоце да рад 
прочитају. 

Део главног текста семинарског рада који представља разраду теме треба 
да је најобимнији. Његова конкретна садржина зависи од задате теме. Увек 
најпре треба изложити опште и основне (попут објашњења термина из наслова 
рада), а потом детаљне и подробне чињенице, уз обавезно навођење 
литературних извора за сваку.  

Уколико дајете податке о комплексности неке биоценозе, флоре, фауне 
или фунгије, немојте децидирано писати број врста, јер увек постоји могућност 
да их нема толико (због: протока времена и промена које су задесиле биотоп, 
застарелости података, непотпуности истраживања без обзира на то који је 
научник и колико дуго радио и др.). 

Да би избегли материјалне грешке, између осталог водите рачуна о 
старости података које износите, да се не би десило да у тексту напишете 
„према савременим истраживањима“, или „у новије време“, „недавно је 
утврђено“, а извор је стар можда и више деценија! Такође водите рачуна о 
географским одредницама у контексту историјских чињеница, да не буде 
извор о подацима из Социјалистичке Федеративне Републике Југославије, а Ви 
пишете „у нашој земљи“. 

У текст семинарског рада ћете врло вероватно уметати слике и табеле. 
Детаљи о њиховом сређивању изложени су нешто касније, у сегменту техничко 
сређивање рада. НЕ ЗАБОРАВИТЕ ДА ИХ КРОЗ ТЕКСТ СПОМЕНЕТЕ БАР 
ЈЕДАН ПУТ. У противном, чему оне у Вашем раду? Позивање на слике кроз 
текст може бити двојако. Ево примера: 

− Варирање праћених параметара је приказано на Сл. 1.  

− Праћени параметри су варирали (Сл. 1).   
Слично је и са позивањем на табеле, само што тада користите скраћеницу Таб. 

Приликом коришћења слика обавезно у потпису слике, након њеног 
редног броја и објашњења шта представља, у загради допишите из којег је 
извора. Уколико је то нека Ваша или позајмљена фотографија, онда пишете 
фото Презиме Име (или иницијал), годину када је снимљена и евентуално место 
и/или повод. При преузимању слика са интернета водите рачуна о ауторским 
правима4, тј. избегавајте слике које су ауторски заштићене. Остале напомене о 
илустрацијама су у овим упутствима дате касније, у делу приче о техничком 
сређивању рада. 
 

 

Водите рачуна о стилу и правопису. Погледајте Прилог 2. У њему су 
изложене најчешће правописне и стилске грешке у семинарским радовима 
наших студената. 

 

                                                           
4
 Закон о ауторским и сродним правима – објављен у Службеном гласнику Републике Србије, 

бр. 104/2009, 99/2011 и 119/2012, доступан на сајту 
http://www.mpn.gov.rs/images/content/nauka/pravna_akta/intelektualna_svojina/Zakon_o_auto
rskom_i_srodnim_pravima.pdf . 
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Не дозволите да вас количина расположивих података уплаши, збуни и 
поремети у остварењу првобитног, са предметним наставником утврђеног, 
концепта рада. Један од циљева писања семинарских радова је, управо, да 
младог човека истренира да из мора информација успешно извлачи само битне 
и то оне које ће моћи добро да уклопи у „своју причу“. Уколико у тексту нису 
уз чињенице наведени литературни извори из којих оне потичу, а ни аутор сам 
се том проблематиком не бави као истраживач, или су без наводника и 
навођења извора преписане читаве реченице или већи делови текста (цитати), 
онда се рад сматра ПЛАГИЈАТОМ, тј. крађом туђе интелектуалне својине, што 
је и Законом5 кажњиво! 

 

3.3.1. Како кроз текст наводити литературне изворе  
из којих су подаци? 

 
Најбоље ће то илустровати пример, пасус из једног студентског 

семинарског рада: 

„Бакренасти мољац Plodia interpunctella (Hübner, 1813) је једна од економски 

најзначајнијих штеточина ускладиштене људске и/или животињске хране у свету 

(VUKAJLOVIĆ i sar., 2013), пре свега жита и производа од жита (JACOBS and CALVIN, 2001). 
Бакренасти мољац је и у нашој земљи економски штетна врста и налази се на списку 

датом „Правилником о утврђивању листе економски штетних организама“ („Сл. 
Гласник РС“, бр. 25/2008). Бакренасти мољац је типични полифаг, који се храни разним 

зрневљем, сточном храном, сувим воћем и бројним другим производима (МАЦЕЉСКИ, 
1999). Једна од првих свеобухватних студија о P. interpunctella објављена је у раду 
HAMLIN-а и сарадника 1931. године. У овој студији је бакренасти мољац означен као 

штеточина жита, производа од жита и више од 20 различитих врста орашастих плодова 

и воћа. Производи и групе производа, које инфестира бакренасти мољац, набројани су 

у великом броју студија (JOHNSON et al., 1992, 1995; SEDLACEK et al., 1996; NANSEN and 
PHILLIPS, 2003, 2004; NANSEN et al., 2004).“ – Кочовић, 2014. 

Примећујете да су презимена домаћих аутора писана и ћирилицом и 
латиницом. То зависи од тога којим писмом је писан текст извора. Ако су два 
аутора истог извора, пишемо оба презимена, повезујући их словом „и“ ако је 
ћирилица, „i“ ако је латиницом штампан извор, односно „and“ или „&“aко је 
страни извор. У случају да је више од два аутора писало изворни текст иза 
презимена првог пишемо „и сар.“, „i sar.“, односно „et al.“ (што је скраћеница од 
латинског „et alii“, а значи „и сарадници“). 

Уколико сте преузели део текста у непромењеном облику, тј. преписали 
га из извора без мењања, онда тај текст морате ставити под наводнике 
(цитирати) и обавезно навести из ког је извора, на неки од горе описаних 
начина. 

 

                                                           
5
 Исто као 4. 
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3.4. Закључак 

Закључак семинарског рада треба да буде кратак и јасан преглед 
резултата рада. Зависно од теме, може садржати кратко лично студентово 
виђење значаја обрађене теме, по могућству и практичног, тј. са евентуалним 
предлогом неког решења. Закључак је, заправо, одговор на циљ дефинисан у 
уводу семинарског рада. 
 

3.5. Литература 

Литература на основу које конципирате семинарски рад мора бити 
квалитетна, тј. одговарајућа теми, научно валидна, доказано тачна, кроз текст 
пажљиво, прописно и тачно навођена, а у попису литературних извора на крају 
рада сложена правилно и прегледно. Зависно од тога да ли је основни текст 
рада писан ћирилицом или латиницом, литературне изворе у том попису треба 
поређати по азбучном, односно абецедном редоследу, гледано по почетним 
словима презимена првог (или јединог) аутора. 

Веома је важно да у попису литературе буду наведени стварно 
коришћени извори и да сви извори споменути у тексту буду наведени, као и 
обратно (да сви извори дати у попису јесу у тексту навођени бар по један пут).  

Неопходно је да буду испоштована правила за писање литературних 
извора. Она су прецизирана у договору са предметним наставником, тј. треба 
да поштују пропозиције стила за писање литературних извора који је наставник 
одредио, а који је уобичајен у научној дисциплини из које је тема семинарског 
рада.  
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4. ТЕХНИЧКО СРЕЂИВАЊЕ РАДА 
 
 Пошто је на највећем броју рачунара код нас инсталиран оперативни 
систем Microsoft Windows, упутства која следе су везана за коришћење 
програма за обраду текста Word, израду табела Excel, сређивање слика Photo 
Shop и евентуалну припрему презентације за „брањење“ семинарског рада 
Power Point. Подразумева се да разумете енглески језик и поседујете основна 
знања потребна корисницима рачунара. 
 Текст који следи ће Вам можда открити неке пречице за бржи рад. 
 

4.1. Сређивање текста 

 У овом делу текста су изложене основне напомене, важеће за већину 
семинарских радова. Ипак, пре него што почнете да сређујете свој рад питајте 
предметног наставника да ли треба да нешто буде другачије. 

Да би могли да примените савете који следе, а везани су за коришћење 
Word-а, потребно је да у понуди изгледа екрана (View) изаберете Print Layout и 
активирате лењире (Ruler). 
 

4.1.1.  Изглед странице 

 Величина странице. Углавном је формат А4. Уколико је другачији, 
промените га помоћу Page Layout и Size. Могуће је да ћете због величине неког 
прилога (табеле, схеме, слике и сл.) неке листове морати да оријентишете 
попреко. Тада у Page Layout под Orientation изаберите Landscape.  

Маргине треба да буду довољне за нормалан рад штампача, ако рад 
треба да предате у штампаном облику. Уколико рад планирате (у договору са 
наставником) да штампате обострано (што је за похвалу, јер показујете свест о 
потреби очувања шума и штедње!), онда треба да користите Mirrored margins, са 
тим да унутрашња маргина (Inside) треба да буде бар за 0,5 cm већа него 
спољашња (Outside), због увезивања папира при коричењу или паковању у 
фасциклу. Маргине можете мењати избором из понуде, или помоћу Page Layout 
→ Margins → Custom Margins и подешавања бројева. Трећи начин је коришћење 
стиснутог левог тастера миша док је у позицији на почетку или крају лењира  
који су изнад текста и са леве стране екрана. 
 Хедер и футер (Header, Footer) су делови странице изнад и испод њеног 
основног садржаја, тј. припадају горњој и доњој маргини. У њима треба да су 
посебни подаци о тексту, техничке природе (име аутора, наслов и/или наслов 
поглавља), али откуцани са не више од 50 симбола (слова и размака). Пре 
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уписивања текста у ове просторе треба дефинисати да ли желите да хедери 
буду различити на парним и непарним страницама. То постижете у Page Layout 
→ Page Setup → Headers and Footers → Differrent odd and even. Текст у хедер или 
футер уносите (исто је и када желите да нешто ту промените) тако што најпре 
курсором уђете у простор одговарајуће маргине и омогућите едитовање 
дуплим кликом левог тастера миша. У хедере можете, а не морате, да унесете 
своје име, скраћени назив семинарског рада, наслов поглавља, број странице, а 
у футер најчешће улази нумерација странице.  

Увлачење пасуса постижете типком табулатора на тастатури (лево од 
типке Q, а носи ознаку �). НЕ ТИПКАЊЕМ РАЗМАКНИЦЕ на тастатури! 
Најчешће је увлачење (величина табулатора) 1,27 cm. Међутим, у случају 
потребе да је другачије, најједноставније је да користите горњи клизач 
(троуглић) на горњем лењиру. Померате га довођењем курсора на њега и 
померањем на жељену позицију док држите притиснут леви тастер миша.  

Скраћивање редова са леве и десне стране можете извести на сличан 
начин, померањем клизача на почетку и крају горњег лењира. Друга је 
могућност да форматирате пасус помоћу команди у понуди Home → Paragraph 

→ Indentation.  
Равнање текста по левој и десној страни, или центрирање најлакше 

постижемо коришћењем адекватних иконица у понуди Home. Можете и преко 

Нome → Paragraph → Indents and Spacing → Aligment → кликом изаберете жељено. 
Проред између редова такође можете да мењате помоћу Home → 

Paragraph → Spacing. Због рационалног трошења папира пожељно је да проред 
буде што гушћи, али не на уштрб читљивости и уредности. Предлажемо Line 

Spacing → Single или 1.5 lines. Истицање неких пасуса и наслова можете постићи 
и уметањем нешто већег простора изнад и/или испод (Before односно After) 
њиховог реда. 

Колоне. Уколико желите да текст средите у две или више колона 
искористите Page Layout → Columns и кликните на жељено. Да би се вратили на 
уобичајено куцање у целим редовима на тој истој страници, најпре прекините 
ту секцију помоћу Page Layout → Breaks → Continuos. 

„Преламање“ страница. Да би текст деловао уредно и да при 
евентуалним накнадним преправкама не доживи распадање, нпр. да због 
уметања или брисања делова наслов не остане сам на дну странице, или потпис 
слике пређе на наредну страницу, препоручљиво је коришћење „обичног“ 
чврстог прелома посредством Insert → Page Break или неке друге варијанте 
прелома помоћу Page Layout → Breaks и кликом изаберите најподеснији. 

Нумерација страница је неопходна, поготово ако је рад дужи од пет 
страница. Пречица за ову операцију је Insert → Page Number → изаберете из 
понуда најподеснију позицију, а у Format Page Numbers подесите да почетни број 
буде 0 (нула). Ако сте текст делили на секције са различитим форматом пасуса, 
онда у нумерацији страница треба да пазите да се у наредним секцијама она 
наставља (изаберите опцију Continue from previous section).  

Само насловна страна остаје ненумерисана. Да то постигнете користите 
Page Layout → Page Setup → Headers and Footers → Different first page. 
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4.1.2. Фонт 

 Пожељно је да читав текст семинарског рада буде писан истим типом 
слова (фонтом), по могућству ћирилицом6 (изузев мерних јединица, латинских 
имена, презимена научника које цитирате или спомињете као творце метода и 
сл., као и литературних навода који су у оригиналу латинични). Будући да је 
семинарски рад везан за научна достигнућа и чињенице, треба избегавати 
претерано китњасте, теже читљиве фонтове. Величина слова и стил (искошена, 
тј. италик, замашћена, тј. болд) кроз текст могу местимично бити различити, 
ако треба да неки делови (попут: наслова; литературних извора навођених у 
тексту; натписа за табеле; потписа слика; најбитнијих појмова; латинских 
назива родова, подродова, врста и подврста; фуснота и др.) буду и визуелно 
истакнути у односу на основни текст.  

Уколико сте изабрали Times New Roman фонт, основни текст је довољно 
писати словима величине 12 pt, са једноструким (Single) проредом. У том 
случају ће на једној страници бити око 50 редова текста и око 95 карактера 
(слова и размака) по реду. 

Потписе слика и натписе табела можете писати словима величине 11 pt. 
Исто важи и за попис литературе, ако наставник не одреди другачије. 

Фусноте су кратке напомене, објашњења неких појмова или извора 
података. Појављују се на дну странице или испод текста на некој страници, 
написане ситнијим словима у односу на основни текст (у нашем случају 10 pt), а 
почињу експонентно написаним симболом или бројем. Такав исти симбол или 
број је и у основном тексту иза појма који у фусноти објашњавамо.  

Како уметнути фусноту у текст? Курсор миша доводимо у положај иза 
последње речи појма који ћемо објашњавати у фусноти, отворимо понуду 
References → Insert Footnote → рачунар сам генерише понуду, ако то није прва 
фуснота у тексту, тако што је упише и на месту где је био курсор и на дно 
странице. Потом укуцавамо коментар на дну странице. Ако формирамо прву 
фусноту у тексту и не желимо да то буде аутоматски формат, онда уместо Insert 
Footnote бирамо Footnotes где одлучујемо где ће она бити (Bottom of Page или 
Below Text Format), бирамо Format и одлучујемо да ли ће такве бити фусноте у 
целом тексту, или само у секцији у којој тренутно радимо.  

Слично можемо да организујемо Endnote, тј. коментаре или објашњења 
који ће оне бити на крају целокупног текста. 
 
 

4.1.2.1. Писање наслова  
 При писању наслова најбоље је користити различите формате слова, тј. 
стилове, за наслове различитог ранга. Постоје већ направљени стилови у 
понуди (Home → Heading1, 2, 3…). Њихова употреба ће Вам олакшати 
                                                           
6 Према Уставу Републике Србије (усвојеном на седници Народне скупштине Републике Србије 
30. септембра 2006. године, познатом и као Митровдански устав), српски језик и ћирилично 
писмо су у службеној употреби на читавој територији Републике Србије.   
По правопису, ћирилица и латиница су стандардна писма савременог стандардног српског 
језика (постоји двоазбучје).  
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састављање „Садржаја“, пошто се он тада аутоматски прави. Наслове можете и 
сами креирати сходно потребама свога рада. 

Избегавајте коришћење подвлаченог текста за писање наслова.  
Уколико је семинарски рад веома обиман, може имати до пет нивоа 

наслова. Ипак, препоручљиво је три. Нумерисање наслова и поднаслова 
доприноси прегледности рада. Једино сегмент „Литература“ не треба 
нумерисати. 

Пазите да наслов не остане да „виси“ на дну странице без пратећег 
текста (енглески израз је удовица, тј. widow). 
 

4.1.2.2. Истицање појмова и/или речи 
 Појмове које желите да истакнете кроз текст као кључне, можете писати 
„масним“ словима, тј. болдирано, италиком или евентуално другим фонтом (ово 
примењујте само изузетно, у текстовима попут овог Упутства). 
 Латинска имена родова, врста и биљних асоцијација у тексту 
истакните косим словима (италиком). Водите рачуна о томе да их увек пишете 
латиницом, и да почињу великим словом.  

Приликом првог спомињања неке врсте треба написати њено потпуно 
име: Rod (Podrod) vrsta Prezime аутора који је врсту описао, година описа. Име 
подрода може изостати, ако род није подељен. Пазите да почетна слова имена 
родова и подродова треба да буду велика, док име врсте углавном почиње 
малим словом. Називе виших таксона такође пишемо великим почетним 
словом. 

Уместо целог презимена аутора имена врсте, можете писати и научно 
прихваћено скраћено име. За Линеа, нпр. уместо Linnaeus, 1758 веома често се 
користи само L., али уместо (Herbst, 1797) скраћено пишемо (Hbst.). Ређи је случај 
да име врсте садржи презимена два научника, попут Панчићеве оморике Picea 
omorica (Pančić) Purkyně 1877. Заграде уз подрод, као и уз годину описа треба 
писати усправним, не италик, симболима.  

Година описа неких врста је у загради, а неких није. У томе треба бити 
прецизан и пажљив, јер постојање заграде уз годину указује на чињеницу да је 
та врста таксономски променила позицију у систематици у односу на 
првобитни научни опис7. Да не погрешите, најбоље је да се ослоните на 
актуалне, светски признате базе података (Прилог 3) . 

Водите рачуна о томе да подаци о називу врста и њиховој таксономској 
позицији буду савремени, тј. данас важећи, као и да кроз читав рад користите 
исто име за једну врсту, а не час име, час неки од синонима. На пример, 
Juniperus sibirica je прихваћено име за Juniperus nana (патуљаста клека), Quercus 

                                                           
7 Промена може бити у мењању припадности подроду, роду, фамилији... Детаље можете наћи у 
Међународном кодексу ботаничке номенклатуре доступном на адреси 
http://www.bgbm.org/iapt/nomenclature/code/saintLouis/0001ICSLContents.htm и 
Међународном кодексу зоолошке номенклатуре доступном на адреси 
http://iczn.org/iczn/index.jsp, или преводима на хрватски  http://hrcak.srce.hr/10899 и  
http://hrcak.srce.hr/28877 . 
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frainetto за Quercus conferta (храст сладун), Quercus petraea за Quercus sessiliflora 
(храст китњак), Zootoca vivipara за Lacerta vivipara (живородни гуштер)...  

У литературним изворима ћете налазити застареле таксономске податке. 
То не значи да су ти извори неупотребљиви. Напротив! Само ћете обавезно за 
сваку наведену врсту консултовати савремене, данас валидне базе података 
(погледајте Прилог 3) где су стари називи дати као синоними и ажурирати име. 

Могуће је да у навођењу врста није дато име конкретне, већ је остављена 
као неопредељена. Тада уместо латинског имена врсте (почетно слово је мало!) 
пишете sp., али не италиком. Нпр. Lumbricus sp.  

Уколико набрајате врсте, потрудите се да их ређате по систематској 
хијерархији. Ако је две или више врста из истога рода, онда их пишите једну за 
другом, али не треба свакој наново приписивати име рода, већ само иницијал 
(италиком) са тачком.  

Уколико је род издељен на подродове, врсте из истог подрода у попису 
врста ређамо једну иза друге, по абецедном реду на основу првог слова 
латинског имена врсте. 

  

4.2. Сређивање табела 

Табеле су, као и слике, засебне целине у Вашем раду, тј. свака за себе 
мора бити јасна, попут целе приче. Стога је веома битно како их конструишете 
и именујете, тј. натписујете табеле и потписујете слике.  

Табеле, као ни слике, не треба да буду одмах испод наслова поглавља, тј. 
да њима поглавље почиње.  
 Tабеле је могуће конструисати у самом Word-у или у посебном програму 
(Excel) који омогућава и неке основне математичке операције (попут сумирања, 
тј. сабирања бројчаних података).  

Ако је табела једноставна, биће довољна прва могућност (рад у Word-у). 
У том случају идите путањом Insert → Table → маркирање броја поља 
(хоризонталних редова и вертикалних колона) колико табела треба да садржи. 
Уколико се деси да сте при овом планирању предвидели премало редова (или 
колона) онда можете накнадно уметати нове, тако што поставите курсор у поље 
у односу на које је потребно проширење, кликнете на десни тастер миша и 
изаберете кликом из понуде уметање реда изнад (Insert Rows Above), реда испод 
(Insert Rows Below), колонуе лево (Insert Columns to the Left) или десно (Insert 

Columns to the Right).   
Уколико користите другу могућност, спремну табелу можете уметнути у 

текст као копирани детаљ из постојећег документа или Insert → Table → Excel 

Spreadsheet чиме отварате празну матрицу за табелу.  

 
Основно уређивање табеле у смислу шпартања линија и бојења поља 

(ћелија) у њој могуће је помоћу иконица видљивих у командној линији у Word-
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у под Home, у рубрици Paragraph, препознатљивих као кантица са бојом и 
„прозорчић“. Обе имају падајући мени са понудом. 

Разне друге могућности за сређивање табеле у Word-у се крију у понуди 
која се отвара кликом на десни тастер миша док је курсор на табели. Могуће је 
и кликом левим тастером миша док је курсор на крстићу састављеном од 
стрелица у горњој командној линији отворити понудау Table Tools са 
могућностима дизајнирања (Design) и просторног уређивања (Layout) табеле. У 
обе варијанте имате нпр. могућност за мењање смера текста у изабраној ћелији 
табеле (Text Direction). 
 
 Табелу натписујете именом у којем је њен редни број, јасни опис онога 
шта је у подацима у табели и извор података (осим ако су оригинални, тј. плод 
Вашег истраживања). Величина слова у натпису је обично мало мања него у 
основном тексту (ако сте писали словима од 12 pt, за наслов табеле користите 11 
pt. Натпис је најчешће постављен центрирано у односу на ширину листа и 
табеле. Нпр.  

Табела 1. Величина главених капсула (у mm) и старост ларви (у данима) 

за сваки ларвени ступањ (према Triggs, 2011). 

 
 

4.3. Сређивање слика 

Под сликама у овом Упутству обједињени су фотографије, схеме, цртежи 
и графикони.  

Пазите да изаберете одговарајућу слику (да не погрешите објекат, а ни 
амбијент). Уколико преузимате са интернета или скенирате илустрацију из 
штампаног извора, или са фотографије, водите рачуна о величини и 
резолуцији, тј. оштрини слике. Упоредите сами слике које следе.  

 

   
 

Лева је оштрине 310х310 и очигледно је мутна, а десна има 2272х1704 пиксела и 
далеко је квалитетнија. Не узимајте слике чија је резолуција мања од 350х350 



�     Како написати семинарски рад из биологије?     � 
 

17 

пиксела, ако у Вашем раду или на слајду за презентацију планирате да 
илустрације буду величине 5х5 cm или веће. 

Слику можете квалитативно да мењате помоћу клика на слику, Format и 
избором Brightnes, Contrast или Recolor.  Неке последице су приказане на наредне 
три слике. 
 

   

Слику потписујете центрирано: слика, редни број, јасни опис онога шта 
је на слици и извор података (осим ако су оригинални, тј. плод Вашег 
истраживања). Пример:  

Слика 5. - Развојни стадијуми (јаје, ларва и лутка) врсте Cryptolestes ferrugineus 

(http://agspsrv34.agric.wa.gov.au). 
 
Будући да најчешће слике нису димензија које су Вама потребне, 

мораћете да их развлачите или скупљате. Ово радите искључиво по 
дијагонали! У противном ћете добити деформисани објекат, као на следећој 
слици.  
 

 
 

 Величину слике можете да мењате и обрезивањем: клик на слику → 
Format → Crop → доведите курсор на вођицу (има их осам – на ћошковима и 
срединама страница слике) од које почињете скраћивање, стиснутим левим 
тастером миша водите курсор до одговарајуће позиције и отпустите. Овај захват 
омогућује да избегнете нежељене делове (нпр. треба да прикажете шумску 
врсту, али немате извор из шуме, већ из неке баште – обрежите објекат тако да 
се не види амбијент).  
 

И табеле и слике треба да су постављене на средини реда, ако имају 
ширину приближну његовој. Међутим, можете и да изаберете да су оне уз 
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спољашњу маргину, а текст их окружује тако што ћете кликом на леви тастер 
миша док је курсор на објекту (за табелу треба кликнути на крстић од четири 
стрелице који се појављује код левог горњег угла) у понуди у горњој командној 
линији добити нову могућност: за слику Picture Tools → Format → Wrap Text → 
кликом левим тастером миша изабрати жељено; за табелу клик на десни тастер 
миша и из понуде изабрати Table Properties → Table → Text wrapping → клик на 
жељено левим тастером миша. При оваквом позиционирању слика и табела 
њихов потпис, односно натпис треба сместити у текстбокс (Insert → Text Box), 
који ћете при евентуалним каснијим премештањима померати када и објекат 
којег прати. Обликовање и сређивање текст бокса је налик на сређивање слика 
(кликом на бокс појављују се вођице за регулисање величине, а помоћу клика 
десним тастером миша позивате Format Text Box и бирате жељено). 
 За квалитетније сређивање слика потребно је познавање рада у програму 
Photo Shop. Тада слике припремате као посебне документе и инсертујете их на 
жељена места у тексту. 
 Уколико желите да су слике и табеле уоквирене, онда избегавајте 
пренаглашено дебеле рамове. У табелама не користите пренаглашене линије, а 
препоручљиво је не користити вертикалне. 
 
 

4.4. Сређивање литературних извора 

Као и код наслова који се аутоматски пакују у садржај, слика и табела 
сложених у листе, прављења фуснота, евентуалног формирања индекса битних 
појмова и латинских назива, и у сређивању литературе, Word нуди већ 
спремљене пречице и стилове. Проанализирајте под References Insert и Citation 

Style и испробајте.  
Ипак, можете радити и „ручно“. Текст који следи може Вам деловати 

компликовано. За сваки случај, очигледан пример сређеног пописа литературе 
је у Прилогу 6. 

4.4.1. Стилови за писање литературних извора у попису литературе 

 
Писање списка коришћене литературе је могуће на више различитих 

начина (Прилог 3). Разлике су углавном у: позицији броја који означава годину 
објављивања и знацима интерпункције који га прате; писању читавог имена 
аутора  или само иницијала (презиме обавезно пишете цело!); истицању типом 
слова (најчешће искошавањем, тј. италиком) назива часописа или наслова дела 
из којег је дати извор података; навођењу или ненавођењу издавача; навођењу 
само прве, или и завршне странице, ако је у питању научни рад или поглавље у 
књизи; коришћеним знацима интерпункције...  
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У биолошким научним часописима је најчешће у употреби АПА 
(American Psychological Association8) или модификован АПА систем. Ево како 
би по овом систему написани изгледали поједини типови коришћених 
литературних извора: 
 

Књига (укључујући уџбенике): 
Симић, В. Симић, С. (2009). Екологија копнених вода.  ПМФ Крагујевац, Биолошки 

факултет. Београд. 

Shipley, W. C. (1986). Shipley Institute of Living Scale. Los Angeles, CA: Western 

Psychological Services. 

За електронски доступне књиге одмах иза наслова у угластој загради треба 
написати информацију о формату текста, нпр. pdf, а уместо издавача и места 
штампања уписати ДОИ број9 (уколико га извор има). 
 

Поглавље из књиге: 
Цинцовић, Т., Којић, В. (1976). Poales. Из М. Јосифовић (ур.) Флора СР Србије VIII (стр. 

259-472). Српска академија наука и уметности, Београд. 

Chow, T. W., & Cummings, J. L. (2000). The amygdala and Alzheimer’s disease. In J. P. 

Aggleton (Ed.), The amygdala: A functional analysis (pp. 656–680). Oxford, England: 

Oxford University Press. 

Објашњење: (Ур.) односно (Ed.) је скраћено од енглеског израза editor (=уредник). 
 

Рад из научног часописа: 
Anderson, A. K., Christoff, K., Panitz, D., De Rosa, E., & Gabrieli, J. D. E. (2003). Neural 

correlates of the automatic processing of threat facial signals. Journal of Neuroscience, 

23, 5627–5633. 
Domenico, R., Milano, F., Sciò, E. (2012). Inhibitory effect of plant extracts on conidial 

germination of the phytopathogenic fungus Fusarium oxysporum. American J. of Plant 

Sci. 3, 1693-1698. 

Примећујете да је у првом наводу дато читаво, а у другом скраћено име 
часописа. Оба су исправна. 

Ако је рад доступан посредством интернета (тј. онлајн) и има једног аутора: 
Anderson, A. K. (2005). Affective influences on the attentional dynamics supporting 

awareness. Journal of Experimental Psychology: General, 154:258–281. 

doi:10.1037/0096-3445.134.2.258  
 

Значи, при навођењу рада из научног часописа прво пишемо презиме 
аутора, па зарез, иницијал(е) имена, у загради годину објављивања, тачку, 
наслов рада, тачку, назив часописа италиком, број часописа италиком, зарез, 
број прве странице, цртица, број последње странице, тачка, размак и ДОИ број.  

                                                           
8
 У оптицају је шесто издање (АРА 6th Edition) које можете уградити у рад коришћењем 

пречица које Word нуди (References → Style). 
9
 DOI (или doi) број преведено са енглеског језика је дигитални идентификатор објекта, тј. 

јединствени низ симбола и бројева додељен датом електронском извору података или објекту 
по одређеном библиотечком систему, са циљем што лакшег проналажења посредством 
интернет претраге. 
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Саопштење са научног скупа: 

Leclerc, C. M., & Hess, T. M. (2005, August). Age differences in processing of affectively 

primed information. Poster session presented at the 113th Annual Convention of the 

American Psychological Association, Washington, DC. 
 

 Запажате да је за ове изворе веома важно да тачно буде наведен назив 
научног скупа,  и где је одржан. 
 

 
Интернет извори 
 Интернет изворе кроз текст углавном наводимо као веб адресе. Међутим, 
уколико је интернет извор сређен као писани текст, има јасног аутора (или 
више њих), годину објављивања и издавача, онда га кроз текст наводимо као 
било који штампани извор, тј. презименом аутора и годином. И у попису 
литературе га наводимо као штампани извор, али након датог броја страница 
уносимо веб адресу и на крају пишемо податак попут овог [05.11.2014.], који 
значи да сте тога датума приступали наведеној веб адреси и нашли податак 
који наводите. 

 

Са наставником договорени стил подразумева и да ли ће свака наведена 
референца испред добити редни број и како ће он бити писан (у угластој или 
обичној загради, са или без тачке иза броја, или број са тачком без заграде). У 
радовима из молекуларне биологије, физиологије, микробиологије и другим 
биолошким дисциплинама које се у већој мери ослањају на хемију, физику или 
математику, референце су углавном нумерисане и кроз текст управо и 
навођене угластим заградама са бројевима, уместо у виду презимена аутора и 
године објављивања. 

Уређивање изгледа пасуса који представљају појединачне литературне 
референце је такође део стила који одређује наставник или препушта студенту. 
Често су, поготово када референце нису нумерисане, увучени и поравнати по 
левој страни други и сви наредни редови, тако да и визуелно постаје лако 
уочљив почетак сваке референце (погледајте Прилог 6). 
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5. ПРИПРЕМА ОДБРАНЕ И  
ОДБРАНА СЕМИНАРСКОГ РАДА 

5.1. Припрема одбране семинарског рада 

Припрема одбране семинарског рада подразумева израду презентације 
помоћу програма PowerPoint. Oкосница ће вам бити већ у Word-у сређен 
семинарски рад. Време (датум и сат), простор и трајање усменог излагања 
одређује предметни наставник. 

Од теме и пропозиција које је наставник задао зависи колико ће слајдова 
бити у презентацији, као и то да ли ће она имати претежно илустративни или 
текстуални садржај. Први слајд је веома сличан насловној страници рада. 
Наредне слајдове насловљавајте по насловима у раду.  

Садржај слајда треба да буде читак, јасан, видљив и са најудаљенијих 
места у сали. Да би то постигли бирајте контрастну позадину и садржај (текст 
или слике). Ово је прилика да користећи Design прикажете своју креативност, па 
можда и уметнички таленат. 

Да не погрешите при бирању дизајна, ваљало би да знате у којој сали ће 
одбрана бити, какво је осветљење, тј. да ли је могуће замрачивање, и колико је 
оптички добра техника за емитовање (контраст и спектар боја који подржава). 
У супротном ваш труд може бити добрано осујећен и успех умањен. 

Количина информација на слајду треба да буде одмерена. Ако је то текст, 
онда га у виду теза (серије појмова којима ћете се руководити у причи) средите 
у 8-10 редова, бирајући читак фонт. На сликама које следе лево је лош 
(преоптерећен текстом, слабо контрастан), а десно добар слајд. 

 

  
 
Уколико приказујете слике, немојте више од четири стављати на један 

слајд и обавезно сваку потпишите објашњењем шта представља.  
Да би излагање било добро праћено, немојте одједном приказивати 

читав садржај слајда, већ помоћу Animations полако уводите један по један 
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елемент (појам, тезу, слику или табелу). Тако ћете одржавати пажњу слушалаца. 
Пазите и да не претерате са анимационим ефектима, јер то даје резултат 
супротан жељеном – одвлачи пажњу слушалаца од теме вашег излагања, може 
и вас да деконцентрише, а и да „краде“ време. Препоручљиво је да користите 
увек исту, ненападну анимацију, попут Appear или Fade.  

Уколико имате жељу да у своје излагање укључите и неки филмски или 
аудио приказ, то је за похвалу. Ипак, пре одбране обавезно и благовремено 
проверите да ли рачунар са којег треба да емитујете презентацију има техничку 
подршку за то. У супротном потражите помоћ одговарајуће техничке службе 
која ће инсталирати потребан софтвер. 

 

5.2. Јавна одбрана семинарског рада 

 
 Поштујте своје и туђе време.  
 Презентацију благовремено увежбајте. Уколико садржи појмове који вас 
збуњују, добро проучите њихово значење. Замолите пријатеље да вам скрену 
пажњу ако сте склони употреби поштапалица. Не дозволите себи да 
презентацију припремате читаву ноћ пред обрану. Бићете уморни, нервозни, 
несконцентрисани. 
 Немојте на одбрану или испит доћи гладни или поспани. 
 Пристојно се обуците и очешљајте. 
 На одбрану дођите бар 15 минута пре почетка часа, проверите 
осветљеност, загрејаност и проветреност сале, као и исправност рачунара и 
опреме за пројектовање. „Пребаците“ презентацију (са спољашње меморије или 
елекронске поште) у рачунар, отворите и проверите да ли су слајдови какве сте 
желели и да ли је могуће активирање евентуалних видео или аудио прилога. 
  Говорите јасно, довољно гласно да вас чују и најудаљенији у сали. 
Уколико имате трему, не дозволите да вас савлада. Ако ће излагање бити дуго, 
припремите чашу или бочицу воде за себе. Обраћајте се слушаоцима гледајући 
у њих, а не у зид, плафон, под, кроз прозор и сл. Можете повремено 
успостављати и дијалог са слушаоцима постављајући им питања на која по 
очекивању треба да знају одговоре. Пазите на „говор тела“ (не клатите се, не 
жваћите жвакаћу гуму, не шкљоцајте хемијском оловком, не „кршите“ руке, не 
вртите прамен косе и сл.). 
 Поштујте дозвољено време за трајање одбране. 
 Пажљиво слушајте и одговорите на постављена питања. 
 По завршетку часа, обришите своју презентацију са рачунара, да не би 
сметала другима. Искључите рачунар и видео бим. 
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ВАЖНО! 
 

Не заборавите да: 
• Тему за семинарски рад узмете на почетку наставе из датог предмета. 
• Испоштујете правила за израду рада дата у овом Упутству и добијена 

од наставника. 
• Рад завршите благовремено, тј. доставите га предметном наставнику 

по договору (најбоље неколико дана пре јавне одбране или испита), 
како би стигао да га прегледа. 

• Рад достављате у форми коју је одредио предметни наставник (у 
фасцикли, као штампан; у електронској форми, било као Word или 
PDF и евентуално PowerPoint, и то посредством електронске поште 
или преносивих меморијских елемената попут CD или USB флеш 
меморије). 

• Уколико је предвиђено да семинарски рад „браните“, тј. излажете 
јавно, у склопу наставе или на испиту, водите рачуна о концепту 
презентације и дозвољеном времену за излагање. 

• Не дозволите да у тексту, а поготово на одбрани користите појмове 
које не разумете. Да би спречили бруку, док пишете семинарски и 
спремате одбрану проучите значење свих појмова за које нисте 
сигурни да знате шта значе. 

• На одбрани се добро сконцентришите и контролишите да би избегли 
поштапалице (имамо, хм, значи, овај, јел’ тако, иначе, дакле...). 

• Будите одмерени и пристојни. Професор јесте дужан да Вас упути и 
помогне, али поштујте време за консултације и имајте у виду да нисте 
једини студент који од њега тражи помоћ. 

 
 
 

 

� 
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Прилог 1. Изглед насловне странице семинарског рада. 
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Прилог 2.  Честе правописне и стилске грешке у семинарским радовима. 
 

Овај прилог је сачињен на основу досадашњег искуства у раду са студентима. 
 
Неисправно Исправно 

Размаци и знаци интерпункције 
Крај реченице.Почетак реченице. Крај реченице. Почетак реченице. 
Крај реченице .  Крај реченице. 
чине : врста 1 , врста 2 и врста 3. чине: врста 1, врста 2 и врста 3. 
( врста 1 , врста 2 и врста 3 ) (врста 1, врста 2 и врста 3) 
трњина(Prunus spinosa) трњина (Prunus spinosa) 
Quercus petraea- храст китњак Quercus petraea - храст китњак 
Querco - Carpinetum moesiacum Rud. 1949 Querco-Carpinetum moesiacum Rud. 1949 
брдско - планински предео брдско-планински предео 

Писање вишецифрених бројева 
1234567 1.234.567 или 1 234 567 

Писање децималних бројева 
12.345 12,345 

Писање мерних јединица 
25цм 25 cm 
70 Ц 
38 %, 241 ‰ 

70ºС 
38%, 241‰ 

Писање цифарских вредности у тексту 
5 пет 

Остало 
безкичмењаци бескичмењаци 

Стил 
Посматрајући живописну панораму 
овог подручја, човек не може а да не 
размишља о настанку овога 
драматичнога пејзажа и утицаја 
моћних природних сила које су 
учествовале у његовом формирању. 
Посебно обележје својим бистрим, 
зеленоплавим тоновима дају му 
језера, јер су неизбежна у својој 
упечатљивости, миру и тишини. ... 

Врло разуђен и разноврстан рељеф 
овога подручја се формирао 
садејством различитих природних 
утицаја. У њему се истичу  језера. ... 
 

Бесмислице 
сунчана инсолација осунчаност / инсолација 
биљна вегетација вегетација 
синтаксонски синтаксономски 
земљиште типа панкера земљиште типа ранкера 
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Прилог 3.  Неке од база података са валидним таксономским подацима. 

Монера  http://www.britannica.com/EBchecked/topic/389114/moneran  
http://www.taxonomicoutline.org/index.php/toba  

 
Алге     http://www.algaebase.org   
  http://tolweb.org/notes/?note_id=52  

http://ucjeps.berkeley.edu/INA.html  
http://www.environment.gov.au/biodiversity/abrs/online-

resources/glossaries/algae/index.html   
Лишајеви http://www.lichens.lastdragon.org/links.html  
Гљиве   http://tolweb.org/fungi  
   http://eol.org/pages/5559/overview  
   http://mushroomobserver.org  
 
Маховине 

http://www.bio.bas.bg/~phytolbalcan/PDF/14_2/14_2_05_Sabovljevic_%26
_al.pdf  

Васкуларне биљке  http://rbg-web2.rbge.org.uk/FE/fe.html  
http://www.floraweb.de/pflanzenarten/pflanzenarten.html  

 http://www.theplantlist.org  
 http://eol.org/pages/281/overview  
  
Разне животиње http://www.igoterra.com  

http://www.faunaeur.org/index.php   
Рибе    http://www.fishbase.org  

http://www.learnanimals.com/fish.php  
Водоземци и гмизавци http://www.learnanimals.com/reptiles.php  
Птице  http://avibase.bsc-eoc.org/avibase.jsp?lang=EN  

http://www.learnanimals.com/birds.php  
http://eol.org/pages/695/overview  

Сисари  http://www.learnanimals.com/mammals.php  
http://www.mammalogy.org  
http://www.european-mammals.org/php/mapmaker.php  
http://wbd.etibioinformatics.nl/bis/marine_mammals.php?menuentr

y=soorten  
 
Организми у Аустралији 
http://www.environment.gov.au/biodiversity/abrs/online-
resources/bryophytes/index.html  
http://www.environment.gov.au/biodiversity/abrs/online-
resources/flora/index.html  
 
...    
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Прилог 4. Правила за изговор у латинском језику  
(према Popović, 1980). 
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Прилог 4а. Правила за изговор у латинском језику - наставак 

 

Ево примера: 
Rosaceae (изговор: ROZACEE), larvae (LARVE), Curculionidae (KURKULIONIDE),  
coelom (CELOM), Coelenterata (CELENTERATA), Amoeba (AMEBA),  
chamomilla (HAMOMILA), choanae (HOANE), Chondrostoma (HONDROSTOMA), 
chrysaetos (HRIZETOS), Chlamidium (HLAMIDIUM), philosophy (FILOZOFI),  
phylum (FILUM), Bacillariophyta (BACILARIOFITA), Daphne (DAFNE),  
Ctenophora (KTENOFORA), Thero-Salicornietea (TERO-SALIKORNIETEA), 
Plathelminthes (PLATELMINTES), Deschamsia (DESHAMPSIA),  
Aschelminthes (ASHELMINTES), Quercus (KVERKUS), Aquila (AKVILA),  
lingua (LINGVA), Knautia (KNAUCIA), Nikotiana (NIKOCIANA),  
Ciliophora (CILIOFORA), Cicadetta (CIKADETA), ciconia (CIKONIA),  
cicutarium (CIKUTARIUM), Vicia (VICIA), cerebrum (CEREBRUM),  
Cyanopica (CIANOPIKA), Scyphozoa(SCIFOZOA), Calcarea (KALKAREA),  
Lycopus (LIKOPUS), Coleoptera (KOLEOPTERA), Cucurbita (KUKURBITA),  
Cuculus (KUKULUS), Puccinia (PUKCINIA), Coccidia (KOKCIDIA),  
Coccinella (KOKCINELA), Crocus (KROKUS), cruciata (KRUCIATA),  
Octocoralia (OKTOKORALIA), Spirogyra (SPIROGIRA), Nymphea (NIMFEA),  
Cycas (CIKAS), Myosotis (MIOZOTIS), Dytiscus (DITISKUS), Cygnus (CIGNUS), 
polymorphus (POLIMORFUS), sylvatica (SILVATIKA),  Cynoglossum 
(CINOGLOSUM), Classis (KLASSIS), Plasmodium (PLAZMODIUM), Calosoma 
(KALOZOMA),  
isogamet (IZOGAMET), Asio (AZIO), Carex (KAREKS), xerophyta (KSEROFITA), 
Xeranthemum (KSERANTEMUM), amplexicaulis (AMPLEKSIKAULIS),  
Juglans (JUGLANS), Ionopisidium (JONOPISIDIUM)... 
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Прилог 5. Различити системи за цитирање литературе 
  

 Поједине  науке,  сагласно  својим потребама,  обликују цитирање 
литературе по сопственим правилима, тј. систему. Неки од њих су APA 
(Аmerican Psychological Association; подесан је за радове из психологије), 
Chicago (често употребљаван у радовима из друштвених и хуманистичких 
наука), Oxford (такође прилагођен хуманистичким наукама), Harvard (стил који 
практикује кратке назнаке у тексту, нпр. само редни број литературног извора, 
који упућују на детаљан приказ рефернце у попису литературе, MLA (Modern 
Language Association; подесан за лингвистичке радове), Тurabian (подесан за 
друштвене науке), Language Association, AMA (American Medical Association) и 
NLM (National Library of Medicine) прилагођени медицинарима) и други.   

Сваки од система има предности и мане. На предметном наставнику је да 
се определи и изабере најадекватнији, а може предложити и стилску 
модификацију неког од постојећих. 

За књигу чији је наслов "Cornucopia II: a source book of edible plants" цитирање 
по различитим системима би изгледало овако: 

APA (6th ed.) 
• Facciola, S. (1998). Cornucopia II: A source book of edible plants. Vista, CA: 

Kampong Publications. 
Chicago (16th ed.) 

• Facciola, Stephen. 1998. Cornucopia II: a source book of edible plants. Vista, CA: 
Kampong Publications. 

или 
• Michael Pollan, The Omnivore’s Dilemma: A Natural History of Four Meals (New 

York: Penguin, 2006), 99–100. 
Harvard (18th ed.) 

• FACCIOLA, S. (1998). Cornucopia II: a source book of edible plants. Vista, CA, 
Kampong Publications. 

MLA (7th ed.) 
• Facciola, Stephen. Cornucopia II: A Source Book of Edible Plants. Vista, CA: 

Kampong Publications, 1998. Print. 
Turabian (6th ed.) 

• Facciola, Stephen. Cornucopia II: A Source Book of Edible Plants. Vista, CA: 
Kampong Publications, 1998. 

 
Ако Вас ова тема дубље интересује погледајте сајт Универзитетске библиотеке 
Универзитета у Београду (веб адреса је дата у попису литературе).  
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Прилог 6. Пример сређеног литературног списка. 
(преузето из Vukajlović and Živanović, 2014) 

  [1] АDAMOVIĆ, Ž. (1965):  Cerambycidae (Coleoptera) collected in Serbia. Bulletin of the 
Natural History Museum in Belgrade B (20): 147-183. [in Serbian]  

  [2] ANONYMOUS (2010): Rulebook on the Declaration and Protectionof Protected and Strictly 
Protected Wild Species of Plants, Animals and Fungi.  Official Gazette of the Republic of 
Serbia 5: 46-99. [in Serbian]  

  [3] DANILEVSKY, M.L. (2014): A Check-List of Longicorn Beetles (Coleoptera, Cerambycoidea) of 
Europe, 36 pp. Аvailable through:  http://www.cerambycidae.net/europe.pdf. 
[Accessed  on: 17 January 2014].  

  [4] ĐORĐEVIĆ, B. (2002): Contribution to the Studies on Cerambycidae of Serbia. B.Sc. Thesis, 
Faculty of Science, University of Kragujevac, Kragujevac, 39 pp. [in Serbian]  

  [5] EU (1992): Council Directive 92/43/EEC on the Conservation of Natural Habitats and of 
Wild Fauna and Flora. Official Journal of the European Union 206: 1-66.  

  [6] ILIĆ, N. (2005): The Longhorn Beetles of Serbia (Coleoptera, Cerambycidae) – Faunistic Review. 
Author’s Edition, Belgrade, 179 pp. [in Serbian]  

  [7] ILIĆ, N. and ĆURČIĆ,  S. (2013): The longhorn beetles (Coleoptera: Cerambycidae) of 
Rtanj Mountain (Serbia). Acta entomologica Serbica 18(1-2): 69-94.  

  [8] ILIĆ, N., ĆURČIĆ,  S. and  STOJANOVIĆ, D. (2013): The longhorn beetles (Coleoptera: 
Cerambycidae) of the Đerdap National Park (Serbia). Acta entomologica Serbica 18(1-2): 
95-127.  

  [9] IUCN (2013): IUCN Red List of Threatened Species, Version 2013.2. UCN, Gland, 
Switzerland. Аvailable through:  http://www.iucnredlist.org/. [Accessed on: 25 
December 2013]  

[10] MIKŠIĆ, R. and GEORGIJEVIĆ, E. (1971): Cerambycidae of Yugoslavia, Part I. Academy of 
Sciences and Arts of Bosnia and Herzegovina, Sarajevo, 175 pp. [in Serbian]  

[11] MIKŠIĆ, R. and GEORGIJEVIĆ, E. (1973): Cerambycidae of Yugoslavia, Part II. Academy of 
Sciences and Arts of Bosnia and Herzegovina, Sarajevo, 153 pp. [in Serbian]  

[12] MIKŠIĆ, R. and KORPIČ, M. (1985): Cerambycidae  of Yugoslavia, Part III. Academy of 
Sciences and Arts of Bosnia and Herzegovina, Sarajevo, 148 pp. [in Serbian]  

[13] PIL, N. and STOJANOVIĆ, D. (2008): The longhorn beetles (Coleoptera: Cerambycidae) of 
Mt. Fruška Gora. In: ĆURČIĆ, S.B. (Ed.): The Diversity of Coleoptera of the Fruška Gora 
National Park. Part One. Fruška Gora National Park and Directorate of Forests, Ministry 
of Agriculture, Forestry, and Water Management of the Republic of Serbia, Novi Sad, 
pp. 1-88.  

[14] STANČIĆ, J. (2013): The Beetles (Insecta: Coleoptera) of theRam-Golubac Sands (Eastern 
Serbia). Acta  entomologica  serbica.  Special  Issue.  Entomological  Society  of  Serbia, 
Belgrade, 488 pp. [in Serbian, with English summary] 202  

[15] STEPANOVIĆ, Ž. (1980): Natural and geographical characteristicsof the Gledić Mountains. 
Research Proceedings “Gledić Mountains”. Polet Society of  oung Researchers, Kragujevac, 
pp. 3-13. [in Serbian]  

[16] TREBJEŠANIN,  S. (1990): Cerambycidae of Kragujevac. B.Sc. Thesis, Faculty of Science, 
University of Kragujevac, Kragujevac, 27 pp. [in Serbian]  

[17] VELJOVIĆ, V. (1967): Vegetation of Kragujevac. Bulletin of the Natural History Museum in 
Belgrade. Special Edition. Natural History Museum, Belgrade, 108 pp. [in Serbian]  

[18] VUKOVIĆ, N. (1999): Bird Distribution in Modified Habitats – Assay on the Gledić Mountains. 
B.Sc. Thesis, Faculty of Biology, University of Belgrade, Belgrade, 37 pp. [in Serbian]  

Интернет извор:  
http://upload.wikimedia.org/wikipedia/commons/4/49/Relief_map_of_Serbia.png  
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ПОГОВОР 

 

Студент би писање семинарског рада требало да доживљава као креативни, 
стваралачки рад, налик слагању мозаика. Најпре прикупља ваљане коцкице (валидне 
податке, чињенице, информације). Потом их слаже на свој, оригинални начин, али 
поштујући правила (повезује прикупљене чињенице у пасусе и поглавља, као што би 
при слагању мозаика спајао коцкице по бојама и формирао одређене облике). На 
крају, пошто се одлучио за дефинитивни распоред, повезује чињенице својим речима, 
као што коцкице у мозаику међусобно слепљује малтером. На крају свему даје коначни 
облик, одбацујући евентуалне вишкове, тј. технички дотерује текст, проверава 
графичко решење и правопис, сређује попис коришћених литературних извора, као 
што би радио стављајући мозаик у рам и гланцајући коцкице да дођу до изражаја.  

Драге младе колеге, 

Срећно! 
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